
Administration Settings & Tools 
Certain settings and tools have been provided to make managing/monitoring 
your Sentinel RMS License server easier.  Their use is not necessary, but they 
may be useful for trouble shooting or analyzing network usage.  All of these tools 
should be found in your Sentinel RMS server directory (default path is: Program 
Files\Common Files\SafeNet Sentinel\Sentinel RMS Server\WinNT  

 

 

Optional Server configuration settings 
LSERVOPTS - Set License Server Options: Certain properties of the license 
server may be controlled by setting up the local environment variable, 
LSERVOPTS.  The variable has several options as described below.   

-l usage-log-file Specifies the name and location of the license server’s 
usage log file, which enables usage logging. By default, 
usage logging is disabled. 

-z usage-log-file-size  The maximum size of the usage log file. The size can be 
specified in bytes, kilobytes, or megabytes. For instance, 
-z 2000 means 2000 bytes, -z 2k means 2 kilobytes, -z 
2m means 2 megabytes. The default value is 1 mega-
byte. Once the maximum size of the file is reached, the 
license server will create a backup log file unless the -x 
option has been used; the -x option causes the license 
server to simply stop logging transactions. If log file 
backups are not disabled by -x, when the log file reaches 
its maxi-mum size the contents of the log file are moved 
into a new file that has the same name as the original 
log file but which has two numeric digits appended to its 
name. For example, if the original log file is named 
lserv.log, the first backup file will be named lserv.log.00. 
The next time a backup file is created, the new file will 
use the next available backup number (e.g., 
lserv.log.01). The maximum number of backup files is 
99; you can move existing backup log files to another 
directory and the license server will begin again with 00. 
If clients are connected to the license server when the 
backup file is created, dummy records are created for 
any pending transactions in the backup file; 
corresponding dummy records are created in the new 
file. The dummy records are identified by the user name  

-x  By default, on overflow of the usage log file, the file 
contents will be moved into a backup file. New usage 
records are then written to the original file until it 
overflows again. If the -x option is specified, the file will 
not be backed up on overflow; instead the license server 
will simply stop writing further records to the file. 

-f error-file  Specifies the name and location of the error file where 
the license server will log occurrences of unexpected 
conditions. By default, this is disabled until the option is 
specified. Then the license server will append to the 
lserv.log file in the current directory. 



-com percentage Commuter licensing uses the same license tokens as 
other network licenses. To ensure that not all license 
tokens are used up by commuters, set the –com option 
to the percentage of license tokens you want to be used 
for commuter licensing. Once that percentage of tokens 
are used by commuter licenses, no more will be made 
available to commuters until tokens are returned. 

 For Win2000 edit the environment variables by opening the 
“System” control panel and selecting the “Environment” tab.  Type 
the variable name and value string on the lines provided and click 
the set button to enable the variable. 

 
WlmAdmin.exe - Administer License Management Activities: 

Description: Provides information on licensing activities. Includes information on 
license servers detected, details on active licenses, and information on licensed 
users.  WlmAdmin also performs a variety of administrative functions. See below 
for more information. 

Who/Where: Run by an administrative user on a stand-alone, client, or license 
server computer.  Using Windows Explorer, navigate to the location of the 
WLMADMIN.EXE file, and double-click the file to start the program. 

Monitoring Licenses and License Servers: You can use WlmAdmin to see 
what licenses are being serviced by which license servers and see information 
on those licenses. You will see information about each license: whether it can be 
a commuter license, what feature/version is licensed, how many users are using 
the license, the license expiration date, and so on.  

Shutting Down the License Server 

In the license server pane of the main WlmAdmin window, right-click on the 
license server you want to shut down and select Shutdown Server from the 
menu 

Using WlmAdmin to Monitor Licenses and License Servers 

The first time you start WlmAdmin, it shows an empty screen, but as soon as 
you have selected license servers to monitor, WlmAdmin displays information 
about them. You can also see information about licenses on the license servers 
and the users who use them. 

Setting WlmAdmin Preferences 

You can choose what WlmAdmin displays when it starts. From the Edit menu, 
select the Preferences command: 

� To always show the license servers you have defined (see below), select 
the Discover defined servers on startup check box. 

� To automatically discover and display the license servers on your 
subnet, select Discover subnet servers on startup check box. Be sure to 
select Save these preferences to a file to save your choices.  

Other preference settings you can choose are: 

� Show client library error handler messages to pass license management 
error messages from SentinelLM through to WlmAdmin. 

� Broadcast Interval to select the number of seconds between broadcasts 
to the network to discover license servers. 



� Timeout Interval to select the number of seconds at which WlmAdmin will 
stop trying to contact a license server. If you have a large network or a 
slow one, you might want to increase this number if you find WlmAdmin 
has difficulty retrieving information from license servers. 

Selecting the License Servers 

The first step to using WlmAdmin is to select what license servers you are 
interested in monitoring.  To create a list of Defined License Servers: 

1. Go to the Edit menu and select the Defined Server List command. 

2. Type a license server name and click the Add button to add a server to 
the list. If you are not sure of the license server computer’s host name, 
you can wait for WlmAdmin to display license servers in the Subnet 
Servers area of the left-hand pane of the main window to see what 
license servers are available on the network. 

3. Once a license server is defined, you can add more or select a server 
and click Remove to remove it from the list. 

4. Click OK to return to the main WlmAdmin screen. 

To Discover All License Servers on Your Network Subnet 

Go to the left-hand pane of the main WlmAdmin window and double-click 
Subnet Servers. WlmAdmin will broadcast to the network to discover all license 
servers and display them here. 

To Refresh the Network Display 

Right-click on Defined Servers or Subnet Servers and select Refresh to tell 
WlmAdmin to display new information on that group of license servers. You may 
also select Refresh All from the View menu to refresh the display for all license 
servers shown. 

To See Information on a License Server 

Click the name of a license server in the left-hand pane of the main window.  In 
the right-hand pane of the display, you see the IP or IPX address of the computer 
containing the license server and its host name. 

To Add or Remove a License Server from the Defined Server List 

Right-click the name of a license server in the left-hand pane of the main window.  
From the menu, select Add to Defined List or Remove from Defined List.   

To Shut Down a License Server 

Right-click the name of a license server in the left-hand pane of the main window. 
From the menu select Shutdown Server. 

To Add a License Code to the License Server from the Keyboard 

1. Right-click the name of a license server in the left-hand pane of the main 
window. From the menu select Add Feature. To add the license by 
typing in the license code, select From a String. 

2. Type the license code in the License code box. 

3. If this is a redundant license code, enter the token distribution criteria in 
the Distribution criteria box in this format: 
Server1:tokens1^Server2:tokens2... where Server is an IP address, IPX 
address, or host name of the computer containing a redundant license 
server and tokens is the number of license tokens to be allocated to that 



redundant license server. Note that all Server:tokens arguments must be 
separate with a ^ symbol. 

4. To permanently add the license code to the license server license file as 
well as temporarily adding it to the license server memory (only in effect 
until the license server is rebooted), select the Add feature to server’s 
file check box. 

5. Click Add. 

To Add a License Code to the License Server from a File 

1. Right-click the name of a license server in the left-hand pane of the main 
window. From the menu select Add Feature. Select From a File and To 
Server (to add the license code temporarily to the license server 
memory, only in effect until the license server is rebooted) or To Server 
and its File (to add the feature both temporarily to the license server 
memory and permanently to its license file). 

2. Now select the license code file from the standard file selection window. 

To Change the Log File for a Selected License Server: 

To begin a new log file for a selected license server, right-click the license server 
and select Change log file name. 

To See Information on a License 

1. In the left-hand pane of the main WlmAdmin window, click the + sign to 
the left of a license server to see what licenses it is servicing. (Once you 
have expanded the license server information, you can click the - sign to 
collapse the information again.) If a license server does not have a + sign 
next to it, it does not currently have licenses installed. 

2. Click the name of a license. In the right-hand pane of the display you see 
information on the characteristics of the license. The exact information 
you see depends on the license. In addition to basic information, such as 
how many concurrent users can use the license, when it expires, what 
users currently are using the license, the display can include whether the 
license can be used for commuter licensing, and if the license is a 
redundant license. If the license is a redundant license, you will see how 
its tokens are distributed and what license servers can service it. 

3. Double-click a license to see if any users are using the license. (Once 
you have expanded the license information, you can click the - sign to 
collapse the information again.) Tip If a user symbol is red, that user is in 
a queue waiting for an available License. 

4. Click the name of a user. In the right-hand pane of the display you see: 
user name and host name of the computer the user is on. If this user is in 
a reservation group, you see the name of the group. You also see 
information on how long the user has been using this license. 

To Delete a License from the License Server 

To delete a license from a license server, right-click the license name and select 
Remove Feature. The license will be removed from the license server’s memory 
until the license server is rebooted. 

Exiting WlmAdmin 

To leave WlmAdmin, go to the File menu and select Exit. 

 



 

WlsGrMgr - Setting Group Reservations 
Group reservations give you the ability to exercise local administrative controls 
by associating a series of groups with each feature and reserving for each group 
a certain number of license tokens. Any license tokens not specifically 
reserved can be used by anyone. 

Including/Excluding Users or Computers 

Selected users can be allowed to run certain applications or can be prevented 
from accessing applications. This can be used as an additional security measure.   

Certain computers can also be allowed to run or prevented from running 
applications.  This can help to balance application usage when you want to 
prevent users from running applications on heavily loaded computers or file 
servers. 

How the Reservation File Works 

The reservation file tells Sentinel RMS how many license tokens are reserved for 
members of different groups. For example, the Sales department could be a 
group with ten members for which 15 license tokens are reserved. The members 
might be network users or specific computers on the network. The 
reservation file might also tell Sentinel RMS that certain members of the 
group are excluded from taking license tokens. 
The groups defined must be mutually exclusive. Different groups for the same 
feature should not have common users or computers. The number of license 
tokens reserved for a feature cannot exceed the number of concurrent users 
specified in the license code for that feature. 
When the license server receives a request, it checks whether the user making 
the request belongs to a group. If so, and license tokens are available for that 
group, the license server will issue the token(s) and decrement the token 
count on the license server. Otherwise, requests will be serviced with 
tokens that have not been reserved and that are available. Users for 
whom tokens have been reserved have first call on available tokens. 
At start up, the license server consults the environment variable, LSRESERV, for 
the path and file name of the reservation file. If the variable is not set, the local 
directory is searched for the file, lsreserv. If no file is found, the license 
server assumes that no reservations exist. 

Reservation File Characteristics 

The following apply to groups: 

� A maximum of 256 groups with 256 members (user names or computer 
IDs) each are supported. 

� Groups must be mutually exclusive. 

� Different groups for the same feature should not have common users or 
computers. 

� Group names and member names cannot exceed 64 characters each. 

� The number of license tokens reserved for a feature cannot exceed the 
number of concurrent copies specified in the license code for that 
feature. 



� If you want to exclude all members of a group from using license tokens 
for a feature, you can specify 0 tokens. 

� If the number of license tokens reserved is greater than the number of 
concurrent copies specified for the feature in the license code, the 
number of tokens specified in the license code will be used. 

 

Editing the Reservation File (WlsGrMgr) 

The WlsGrMgr utility can be used to create or edit a reservation file. 

 Tip:  You can call WlsGrMgr from within WlmAdmin by using the Edit | 
Reservation File command. 

� To make a new reservation file, select the New command from the File 
menu. Or use the Open command on the File menu to edit an existing 
reservation file.   

Note that if you create a new reservation file in a directory containing an 
existing reservation file, WlsGrMgr will append a number to the name of the 
new reservation file to avoid overwriting the existing one (for example, 
lreserv1, lreserv2, and so on). 
� To add definitions for who can use license tokens for specific licenses, 

right-click in the Feature Name area of the screen and select Add from 
the menu. The New Feature Wizard appears. 

� Click Next. The wizard asks for the feature name and the version 
(optional) of the license. After entering that information, click Next. 

� Now the wizard asks for a group name and the number of tokens to 
reserve for that group. 

� Now you see a box where you can add the members of the group.  Click 
Add to add a new member. You are asked to enter the name of the 
member, and whether it is a user (if so, use the user’s login name) or a 
machine (use the name of the computer on your network). You are also 
asked if you want to include or exclude this user or machine. Click OK to 
finish the definition. 

� Once one or more users are defined, you can click Remove All to 
remove all of them and start over or select a specific member and click 
Remove to remove just that member. 

� Click Finish to go back to the main screen.  At the main screen, you can 
see the results of adding groups and members: 

� After at least one feature has been defined, you can define another 
group to use that feature. Right-click in the Group area and select Add 
from the menu to add a new group. Do not add the same users or 
computers to different groups using the same feature. 

 

Lsusage.exe - Display the Sentinel RMS Usage Log File 
Description: Displays a summary of application usage, providing information on 
license transactions contained in the license server usage file. See below for a 
sample. 



Who/Where: Run from the operating system command prompt by an 
administrative or application user on a stand-alone, client, or license server 
computer. 

Options: One or more of the following options must be specified: 

-l log-file Selects the license server log file to display. Must be 
specified. If this is the only option, the summary will be 
displayed on the screen. 

-c CSV-format-file Specifies the name of an output file to which the output 
will be written in Comma-Separated Values (CSV) 
format. This CSV file can be used with Microsoft Access 
to produce graphical reports. 

-f   feature1[,version1] Specifies feature(s) and version(s) to be included in the 
output. 

     feature2[,version2]… Note that version is optional. If this option is not 
supplied, the output will contain all features and versions 
in the log file. 

-m start-month Specifies the first month (1-12) of the time period to be 
included in the output. If not specified, then the -a option 
is ignored and January 1 is assumed for the start month 
and start day. 

-a start-day Specifies the first day (1-31) of the month to be included 
in the output. For example, if you have specified March 
as the start month, specifying a start day of 1 means that 
the output will be for a time period beginning with March 
1. If not included, and the -m option is included, a start 
day of 1 is assumed. 

-y start-year Specifies the first year of the time period to be included 
in the output. Use four digits to specify the year. If not 
included, then -m and -a are ignored and the output 
begins with the first data in the file. 

-M end-month Specifies the last month (1-12) of the time period to be 
included in the output. If not specified, then the -A option 
is ignored and the default value of December 31 is 
assumed. 

-A end-day Specifies the last day (1-31) of the month to be included 
in the output. If not included, and the -M option is 
included, an end day of 31 is assumed. 

-Y end-year Specifies the last year of the time period to be included 
in the output. Use four digits to specify the year. If not 
included, then -M and -A are ignored, and the output 
ends with the last data in the log file. 

-h  Displays a list of all options that can be used. 

Creating License Server Use Reports 

Sentinel RMS provides the ability on Windows computers to use Microsoft 
Access  to create graphical reports of license server use. To use this feature, you 
will need to use the lsusage -c option to create a comma-separated values 
(CSV) file from the license server log file. See the section above for information 
on this option. By use of other lsusage options, you can create an output file with 
use data for specific features and for specific time periods. Once you have 



created the CSV file, here is how to create graphical reports: Note You must 
have Microsoft Access on the computer on which you want to run reports. Also, 
keep the number of features for which you are generating reports to a reasonable 
number (15 to 20) or the reports may not be very easy to read because there 
simply won’t be room for a clear display. 

To Import the CSV File: 

1. Within Microsoft Access, open the MDB file provided with SentinelLM:  
ReportDB.mdb. 

2. Select the Table tab. 

3. Click New. 

4. Select Import Table. 

5. Select the CSV file you created with lsusage and click Import. Tip In 
Microsoft Access, not all file types are installed by default. If you do not 
have the text file type installed, run the Access Setup program, click Add/ 
Remove, then select Data Access and Change Option to install the text 
file type. 

6. The Import Text Wizard is displayed. Continue to click Next until it asks 
“Where would you like to store your data.” 

7. Select In an existing table and select the table Lservlog. (If instead of 
adding to an existing Lservlog table you want to create a new one, delete 
any rows that are already in the Lservlog table before importing new 
data.) 

8. Click Finish. Don’t forget to keep the table name set to Lservlog. 

To Creating Reports 

Once the log file use data is imported into the Lservlog table as discussed above, 
you can now create reports for that data. 

1. Within Microsoft Access, open the ReportDB.mdb file. You will 
immediately see the SentinelLM report selection screen. 

2. You can now select the date range of the report by specifying Start Date 
and End Date. 

3. Now select the type of report you want to create: 

� Total number of tokens granted per feature 

� Maximum number of tokens granted per feature 

� Average number of tokens created per feature 

� Total usage time per feature 

� Total number of tokens denied per feature 

� Percentage of licenses denied per feature 

Tip: When using lsusage to create the CSV file that is the input to these 
reports, you can limit the data to usage information for specific 
features and versions. 



 
 
Lsrvdown.exe - Shut Down the License Server: 

Description: Shuts down the named license server. 

Format: lsrvdown host_name 

Who/Where: Run from the operating system command prompt by an 
administrative user on a client or license server computer. On Windows 
2000/2003, any user with administrative privileges may use lsrvdown unless the 
license server was started by a user logged in as Administrator, in which case, 
only Administrator can shut the license server down. The computer on which you 
are running lsrvdown must be in the same network domain as the license server 
computer. 

Options: host_name specifies the name of the computer that is running the 
license server that you want to shut down. 

 


